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Legal Notices

Extreme Networks, Inc., on behalf of or through its wholly-owned subsidiary, Enterasys
Networks, Inc., reserves the right to make changes in specifications and other information
contained in this document and its website without prior notice. The reader should in all
cases consult representatives of Extreme Networks to determine whether any such
changes have been made.

The hardware, firmware, software or any specifications described or referred to in this
document are subject to change without notice.

Trademarks

Extreme Networks and the Extreme Networks logo are trademarks or registered
trademarks of Extreme Networks, Inc. in the United States and/or other countries.

All other names (including any product names) mentioned in this document are the
property of their respective owners and may be trademarks or registered trademarks of
their respective companies/owners.

For additional information on Extreme Networks trademarks, please see:
www.extremenetworks.com/company/legal/trademarks/

Contact
If you require assistance, contact Extreme Networks using one of the following methods.

« Global Technical Assistance Center (GTAC) for Inmediate Support

« Phone: 1-800-998-2408 (toll-free in U.S. and Canada) or 1-603-952-5000.
For the Extreme Networks support phone number in your country, visit:
www.extremenetworks.com/support/contact

« Email: support@extremenetworks.com. To expedite your message, enter the
product name or model number in the subject line.

« GTAC Knowledge — Get on-demand and tested resolutions from the GTAC
Knowledgebase, or create a help case if you need more guidance.

o The Hub — A forum for Extreme customers to connect with one another, get
questions answered, share ideas and feedback, and get problems solved. This
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community is monitored by Extreme Networks employees, but is not intended to
replace specific guidance from GTAC.

« Support Portal — Manage cases, downloads, service contracts, product licensing,
and training and certifications.
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Deploying the Virtual Engine on a VMware ESX Server

Engine Deployment

This chapter provides an overview of ExtremeCloud IQ - Site Engine, ExtremeControl,
and ExtremeAnalytics virtual engine deployment requirements and provides instructions
for deploying a virtual engine on a VMware® and Hyper-V server.

Deploying the Virtual Engine on a VMware ESX Server

Deployment Requirements

A virtual engine is a software image that runs on a virtual machine. The ExtremeCloud 1Q
- Site Engine, ExtremeControl, and ExtremeAnalytics virtual engines are packaged in the

. OVA file format defined by VMware and must be deployed on a VMware ESXi™ 6.0
server with a vSphere™ client, or on a VMware ESXi™ 6.5, 6.7, or 7.0 server using the
web client.

For information about the different ExtremeCloud 1Q - Site Engine, ExtremeControl, and
ExtremeAnalytics virtual engine configurations, see the latest ExtremeCloud 1Q - Site
Engine Release Notes.

Deploying the Virtual Engine

Use the following steps to deploy an ExtremeCloud 1Q - Site Engine, ExtremeControl, or
ExtremeAnalytics virtual engine on a VMware ESX or ESXi server.

1. Download the ExtremeCloud IQ - Site Engine, ExtremeControl, or
ExtremeAnalytics virtual engine software image to your local machine where the
clientis installed and running.

To download an engine image:

1. Access the Extreme Portal at: https://extremeportal.force.com/.

2. After entering your email address and password, you are on the Support
page.

3. Select the Products tab and select ExtremeManagement.

4. Select ExtremeCloud IQ - Site Engine in the right-panel.

5. Select a version.
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Deploying the Virtual Engine on a VMware ESX Server

6. Download the ExtremeCloud IQ - Site Engine, ExtremeControl, or
ExtremeAnalytics virtual engine (appliance) image from the appropriate
section.

Suppoit Products Parners
ExtremeCloud™ 1Q - Site Engine
-
)« St
-
Software & Downloads -
- =

Release Notes -
= - Rebiiria D ¥

=

2. Open the VMWare software. From the Host menu, select Create/Register VM.

&
-~
o

B Copdte Rogae vid By St Soow

s — extotal
= {1 Virtuad Miathine
= i xacaw -

3. From the Select creation type panel, select Deploy a virtual machine from an
.OVF or .OVA file. Select Next.
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Deploying the Virtual Engine on a VMware ESX Server
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4. Enter the name of the virtual machine and select the .OVA file. Select Next to
continue.
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5. Select your datastore. Select Next to continue.
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Deploying the Virtual Engine on a VMware ESX Server
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6. Select your deployment options and select Next.
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Deploying the Virtual Engine on a Hyper-V Server

7. Review and select Finish to start the deployment.
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After the .OVA file has finished uploading and importing, you are now ready to begin
configuring the engine.
Shutting Down the Engine

To properly shut down the virtual engine, enter the following command at the login

prompt in the vSphere client Console tab:
poweroff

This shuts down the engine and updates the vSphere client with the new engine state.

Deploying the Virtual Engine on a Hyper-V Server

Deployment Requirements

A virtual engine is a software image that runs on a virtual machine. The , ExtremeCloud
IQ - Site Engine, ExtremeControl, and ExtremeAnalytics virtual engines are packaged in
the .ZIP file format and must be deployed on a Microsoft Hyper-V server.
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Deploying the Virtual Engine on a Hyper-V Server

Deploying the Virtual Engine

Use the following steps to deploy an ExtremeCloud IQ - Site Engine, ExtremeControl, or
ExtremeAnalytics virtual engine on a VMware ESX or ESXi server.

1.

Download the ExtremeCloud 1Q - Site Engine, ExtremeControl, or
ExtremeAnalytics virtual engine software image to your local machine where the
vSphere client is installed and running.

To download an engine image:

1. Access the Extreme Portal at: https://extremeportal.force.com/.

N

After entering your email address and password, you are on the Support
page.

Select the Products tab and select ExtremeCloud IQ - Site Engine.
Select ExtremeCloud IQ - Site Engine in the right-panel.

Select a version.

o g &~ »w

Download the ExtremeCloud 1Q - Site Engine, ExtremeControl, or
ExtremeAnalytics virtual engine (appliance) image from the appropriate
section.
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Deploying the Virtual Engine on a Hyper-V Server

Extrerme Pc

Extract the virtual engine file to a local directory.

Suppodt Products

Software & Downloads

Release Motes

Open the Hyper-V Manager.

Partners

gine

-
.
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From the Action menu, select Import Virtual Machine.

FE Hyper-V Manager [ == =m
File View Help
48 New
2#  [mponiirtulMachine.. e
| . i il Machines
W} |PperVSciing WIN-9GLMPQGAPVO -
Virtual Switch Manager... State CPUUsage  Assigned Memory  Uptime Status New N
Virtusl SAN Manager.. No vitual machines were found on this server. (3 Import Vitual Machine...
Edit Disk... %] Hyper-V Settings.
Inspect Disk... S i
T3 Vintusl Switch Manager..
Stop Service ] Virtual SAN Manager..
Remove Server " 2 =
Refresh | | EditDisk.
v i a
points. = =y Inspect Diskc..
Help .
No vitual machine seiected. @ Stop Senvice
7 Remove Server
(3 Refresh
View »
EH vHep
Details
No tem selected

Displays the Import Wizard.
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Deploying the Virtual Engine on a Hyper-V Server

The Import Virtual Machine wizard opens to the Before You Begin panel.

Import Virtual Machine

Before You Begin

Iﬁl

Before You Begin This wizard helps you import a virtual machine from a set of configuration files. It guides you through

Locate Folder
Select Virtual Machine
Choose Import Type

Summary

[ Do not show this page again

Select Next.

The Locate Folder panel opens.

resolving configuration problems to prepare the virtual machine for use on this computer,

Select the Browse button and navigate to the folder where you saved the engine

image.

Select Select Folder, and then Next.

Import Virtual Machine

f" Locate Folder

Before You Begin
Locate Folder

Specify the folder containing the virtual machine to import.
Folder: |

Select Virtual Machine

Choose Import Type

Summary

L]

) - t < nac_.. b nac_appliance_64bit6... »

Organize »  New folder

¥ @ Downloads Lal
b (M Music

MName

b & Pictures
b @ Videos
a B Local Disk (C))
b ) inetpub
4 || NAC
4 |, nac_appliance_64bit.6.2.0.189_hyperv =
3 nac_appliance_64bit.5.2.0.189
b Ll nac_appliance_64bit.6.2.0.189_hyperv
Perflogs
b ). Program Files
b )i Program Files (x26) vl|[<

Select Folder

Snapshets
Virtual Hard Disks

Virtual Machines

=]
bit6... B |

= * W

Date modified

Folder: | mac_appliance B4bit.6.2.0.189

Select Folder

Cancel
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Deploying the Virtual Engine on a Hyper-V Server

The Select Virtual Machine panel opens.
Select the virtual machine you are importing, and then select Next.

ﬁ Select Virtual Machine

Before You Begin Select the virtual machine to import:

Locate Folder

-

Date Created
Select Virtual Mactine nac_appliance_64bit.5.2.0, 189 2{6/2015 8:07:58 PM

Choose Import Type

Name

Surmmary

< Previous | | Mext = | | Finish | | Cancel

The Choose Import Type panel opens.

ﬁ Choose Import Type
Before You Begin Choose the type of import to perform:
Locate Folder (® Register the virtual machine in-place (use the existing unique ID)
Select Virtual Machine () Restore the virtual machine (use the existing unique ID)
Choose Import Type () Copy the virtual machine (create a new unique ID)
Summary
< Previous | | Mext > | | Finish | | Cancel
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Deploying the Virtual Engine on a Hyper-V Server

9. Select the radio button that corresponds to the appropriate type for your machine.

« Register the virtual machine in-place (use the existing unique ID)—Select
this option if your virtual machine files are saved on your virtual machine in the
correct location.

« Restore the virtual machine (use the existing unique ID)—Select this option
if your virtual machine files are saved on a file share or removable drive and
you want Hyper-V to move the files to the correct location.

« Copy the virtual machine (create a new unique ID)—Select this option if you
have a set of virtual files you want to import multiple times (e.g., if you are
using them as a template for new virtual machines).

10. Select Next.

The Summary panel opens.

Before You Begin
Locate Folder

Select Virtual Machine
Choose Import Type
Configure Processor
Connect Network

Connect Network

Summary

Import Virtual Machine L2 |

_,/’..’-r’ Completing Import Wizard

‘You are about to perform the following operation.

Description:

virtual Machine:
Import file:

Import Type:

Mumber of processors:
Metwork connection:
Metwork connection:

<

nac_appliance_&4bit.5.2.0,189

C:\NACYnac_appliance_&4bit. 5. 2.0. 189_hypervinac_appliance_&4bit.6.2.0.
Register (keep ID)

4

Intel{R) PRO/1000 MT Network Connection - Virtual Switch

Intel(R) PRO/1000 MT Metwork Connection - Virtual Switch

m >

To complete the import and dose this wizard, dick Finish.

(| [

You are now ready to begin configuring the engine.

« If you are configuring an ExtremeCloud IQ - Site Engine virtual engine, see
ExtremeCloud IQ - Site Engine Engine Configuration.

« If you are configuring an ExtremeControl virtual engine, see ExtremeControl Engine

Configuration.

« If you are configuring on an ExtremeAnalytics virtual engine, see ExtremeAnalytics
Engine Configuration.
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Pre-Configuration Tasks

ExtremeCloud 1Q - Site Engine Engine
Configuration

After the ExtremeCloud 1Q - Site Engine virtual engine has been deployed on a VMware
ESX or ESXi server, or a Hyper-V server using the instructions in Engine Deployment,
you are ready to perform the initial engine configuration process described in this
chapter.

This chapter also includes information on how to change your engine settings following
your initial configuration, and how to upgrade or reinstall the engine software.

Pre-Configuration Tasks

Ensure that you have the following information prior to executing any of the procedures in
this chapter:

« Engine hostname, IP address, and netmask
« Default Gateway IP address
« Name Server IP address and domain name

NIS (Network Information Services) Server |IP address (optional)

Network Time Protocol (NTP) server IP address

ExtremeCloud IQ - Site Engine And ExtremeAnalytics
Licensing

If you are an existing Extreme Management Center customer, contact your
representative to have your Extreme Management Center license migrated to an
ExtremeCloud 1Q - Site Engine license. The ExtremeCloud IQ - Site Engine license also
includes licensing for ExtremeAnalytics.

NOTES: « ExtremeCloud IQ - Site Engine is a subscription-based -only licensing
model.

« ExtremeCloud IQ - Site Engine is not compatible with ExtremeCloud 1Q
Connect level account. Either the Pilot or Navigator level is mandatory.
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ExtremeCloud 1Q - Site Engine And ExtremeAnalytics Licensing

You can view ExtremeCloud IQ and ExtremeCloud IQ - Site Engine license information
by accessing Administration > Licenses.

There are three tiers of licenses for ExtremeCloud 1Q - Site Engine and devices:

« Pilot - Extreme devices
« Navigator - 3rd party devices
« No License - Status-Only devices

As you begin to onboard ExtremeCloud |Q - Site Engine and your devices, ExtremeCloud
IQ will determine if you meet or exceed the license limits for each license type.

NOTE: Devices that do not have serial numbers or MAC addresses in Extreme
Management Center must be Rediscovered after you upgrade to
ExtremeCloud IQ - Site Engine before they can be onboarded to
ExtremeCloud Q.

For the first 90 days after ExtremeCloud IQ - Site Engine is released, license
usage will not be enforced for devices onboarded to ExtremeCloud 1Q. When
ExtremeCloud 1Q starts evaluating license usage, if your number of devices
exceeds your licenses available, ExtremeCloud IQ - Site Engine transitions
to a license violation state and your access to ExtremeCloud 1Q - Site Engine
features and functionality is locked. To resolve the license shortage you need
to access the Extreme Networks portal or ExtremeCloud 1Q to evaluate the
quantities of available Pilot and Navigator licenses versus the number of
licenses required by ExtremeCloud 1Q - Site Engine.

Licensing for Devices

When ExtremeCloud 1Q - Site Engine has been onboarded, it starts sending requests to
add the devices from its database to ExtremeCloud 1Q.

As devices are added and discovered in ExtremeCloud 1Q - Site Engine, they are
onboarded to ExtremeCloud 1Q, with a request for a license of the appropriate tier
(Navigator, Pilot or No License) that each device will require.

Devices can be marked as Unmanaged in ExtremeCloud 1Q, which means they are not
using a license and available features are very limited.

The following grid details the type of license required by each device and engine type:

Number of
Device Type License Tier Type | Licenses
Per Device
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ExtremeCloud 1Q - Site Engine And ExtremeAnalytics Licensing

Extreme-supported Device
(Includes VSP, SLX, Extreme
Access, VDX, Fabric Manager,
Unified Switching VOSS, Unified
Switching EXOS, Summit Series, Pilot 1
ERS Series, 200 Series, 700
Series, A Series, B Series, C
Series, ICX Series, Security
Appliances, MLXe Series)

Chassis Pilot 1
ExtremeControlengine Pilot 1
ExtremeAnalyticsengine Pilot 1
ExtremeCloud 1Q - Site Engine Pilot 1
Extreme Management Center Pilot 1
vSensor Pilot 1
All Other Devices (Includes Non- Navigator 1
Extreme Device) —

Devices with Ping-Only profile No License 0

No License (These
are not onboarded to 0
ExtremeCloud 1Q)

Devices Added with No Access
Profile

No License (These
Status-Only Devices are not onboarded to 0
ExtremeCloud 1Q)

For HiveOS APs, a Pilot license is required, but currently not enforced in
NOTE: ExtremeCloud IQ - Site Engine Version 21.04.10. These are not onboarded to
ExtremeCloud 1Q through ExtremeCloud 1Q - Site Engine.
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ExtremeCloud 1Q - Site Engine And ExtremeAnalytics Licensing

License Limits and Violations

For each request to add a device to ExtremeCloud 1Q - Site Engine, ExtremeCloud 1Q
determines if there are enough licenses of that type available.

As a result, one of the following actions happens:

« Ifthere are enough licenses, device onboarding is successful.
« If there are not enough Navigator licenses, a Pilot license is used instead.

« If there are not enough Pilot licenses, the request is considered a license violation.

To correct a license limit violation, you must acquire more licenses (and, when the
updated license is sent to ExtremeCloud IQ, it is used by ExtremeCloud IQ - Site Engine).

Devices Marked as Unmanaged

When devices are marked as Unmanaged in ExtremeCloud IQ, they are also
Unmanaged in ExtremeCloud 1Q - Site Engine.

Onboarded Unmanaged devices are indicated in the XIQ Onboarded column of the
Network > Site > Device table by a red X.

For more details on the Network > Site > Device table, visit Onboarding Unmanaged
Devices.
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Configuring the ExtremeCloud 1Q - Site Engine Engine

Related Information

Onboarding ExtremeCloud |IQ - Site Engine

Configuring the ExtremeCloud IQ - Site Engine Engine

To configure the virtual engine to run the ExtremeCloud IQ - Site Engine applications:

1.

In the Console tab of the vSphere client, login as root with no password, and then
press [Enter].
The following screen displays.

wtrense MHetworks, Inc. ExtremeCloud 10 Site Engine belcome to the Site Engine Setup

mtinue with
jed in brackets.
i1l use the

cammot be provided, the prompt will indicate that the item

1) or (Optional). The [e key may be | without
(Optiomal) items. A i ke entered for quired) items.

nd of the setup g, the existing settings will be displayed
and opportunity will be provided to correct any errors.

'ress [enter] to begin setup or CTRL-C to exit:

Press [Enter] to begin the setup.
The Root Password Configuration screen displays:

Root Password Conf iguration

The root password is currently set for this appliance.

ould youn like to set a root h|.1'-:'-:|.|||r'|'l (yrm) [yld

Note: You must set a new root password. The root password will be used to access
the CLI of the ExtremeCloud 1Q - Site Engine VM.
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Configuring the ExtremeCloud 1Q - Site Engine Engine

. Press [Enter] to set a new root password. Enter the new password as prompted.

oot Password Conf iguration

The root password is currently set for this appliance

ou 1 ] like to s&t a root ]r.l'.'-:ur'u:rd. (ysm) [yl

Enter new UNIX |
etype new UNIX

After you create the new root password, a screen displays where you can specify a
user other than root to run the ExtremeCloud 1Q - Site Engine server, if desired.
This user becomes the admin user for the server. (Use the root user account when
performing upgrades and accessing CLI).

Gelect the user to run the server as

o you want to run the Site Engine Server az the root wszer? (yend [yl _

. Entery to use the root user. Accept your selection.
Enter n to either use the "netsight" user or to specify a different user. Re-enter the
password and then accept your selection.

e root userT (ysn) [yl m
=tz ight]:

er netsight:

[fe-enter new password :

In the Suite Network Configuration screen, enter the requested configuration
information for each line and press [Enter].

Enter the IP address of the name server. If you are using a name server, you must
enter a domain name for the engine (appliance). If you are using an NIS server to
authenticate users logging into the engine, make sure the NIS domain name is valid
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Configuring the ExtremeCloud 1Q - Site Engine Engine

or users will not be able to log in to the ExtremeCloud 1Q - Site Engine applications.

Extrenel loiud 10 Site Engine Metwork Conf iguration

r the hostname for the appliance (Required): xigse

- the IP address for xigse [
~ the IF netmask [
- the gateway address [ 1:
the IF address of the name server (Required):

:r the IF address of an alternate name server (Optionall:
Enter the domain nane for xigse (RBeguired): extrensnetuorks . con
o you want to use HIS (ysn) [nlT y
inter the IP address of the HIS server :

Enter the HIS domain name I:I':r'1|'||ir'r'q‘|.:|1 r':-u'1:r1'n|'||r'||_|||r"|-:'-:.|'1|n_

In the Confirm Network Settings screen, you can accept the current configuration
or modify the settings.

2, enter the
tcond I script at a

E extrepnene twor
rsDomain: ’ renenetworks .com

enter selection [81] I

In the SNMP Configuration screen, enter the requested information for each line
and press [Enter].
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Configuring the ExtremeCloud 1Q - Site Engine Engine

SHAF Conf igurat ion

enter

enter

enter

enter

= enter

mation e

agenent applicat

the 5

the 3

the 3

the 5

the S

SHAF uzer name [sapuser):
" authentication protocol ADS or SHA [ADS]:

F authentication credential [swpauthored]:

" privacy protocol DES or AES [DES]:

! privacy credential [sompprivered): _

Wl conplete
vt & choices,
b= ..|'|:L|r-||p1"i.-| imber now or
y script at a later time.

SNRpuUser
ion Protocol : HDE

inter selection [8]:

In the Configure Date and Time Settings screen, select whether you want to use
an external Network Time Protocol (NTP) server. Entery to use NTP, and enter
your NTP server IP address(es). Enter n to configure the date and time manually
and proceed to step 11.

Note that your NTP server should be using the same NTP settings as those
configured for your virtual engine (i.e., the same settings as the VMs that are hosted
on the NTP server).
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Conf igure Date find Time Settings

= ine date and time can be set manual ly or using an external

ime Fr . L
ied to confl igure the date and ti racy of time
for SHAP communicat ions Up to S
server [P addresses may be entered if HTF is used

Do you want to use NTE (gen) [yl?

Fleaze enter a HTP Server [P Address (Required):

ould you like to add another server (ysm) [nd7

10. Inthe NTP Servers validate selection screen, enter 0 to accept the current settings
and proceed to the Set Time Zone screen at step 13.

TP Servers

These are the currently specified NTP servers:

Enter 0 or any key other than a valid selection to complete NTF conf iguration amd continue,

t NP ver ction

date and tisne sanial |.|_|

jion [B]:

11. If you answered no to using an NTP server to set date and time, set the date and
time in the Set Date and Time screen.
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et Date fimd Time

ime is: Fri 14 May 2821 91:01:58 PR EDT

e and time as directed ubhere input is expected in

» digit
& digit

lease enter the month [05]:

"lease enter the day of the month [14]:
"lease enter the year [20211:

'lease enter the hour of day [13):
'lease enter the minutes (04):

"lease enter the seconds [04]:

12. Inthe Use UTC screen, select whether you want the system clock to be set to use
UTC.

tem clock can he t to use UTC. Specifying no for using UTC,
= hardisare ©loc ing localtime.

Do you want to wse UTC fysmd [ndT

13. Inthe Set Time Zone screen, type the number that corresponds to the appropriate
time zone and press [Enter].

set Time Zone

You will now be 1 to enter the time zone Information for thiz system.
are stored in Fil eszone info directory.

Hountain

Paq

Ot her 3 % a graphical list

inter selection [1]1:

14. Inthe Modify Settings screen, you can accept the current configuration or modify
the settings.
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od ify Settings

fill of the information needed to complete the installation of the ExtremeCloud
‘& haz heen entered. Enter O or anyg key other than a
to make a change, enter the

d below.

Inter selection [8] i

The ExtremeCloud IQ - Site Engine application software is automatically installed. This
could take a few minutes. When you see the following screen, configuration is complete.

Extrene MHetworks, Inc, ExtreneCloud I - Site Engine - Setup Complete

wetup of the ExtremeCload 10 Jite Engine iz now c =te. The appliance is
ww operational and ready to acce 1 Details of
he installation are located in the svarslog-sinstall directory.

ontixigse: 5

Note: After you have completed the configuration, it is important to take a snapshot of
your engine configuration to be used in the event an engine image recovery is required.
For instructions on how to take a snapshot, see your vSphere client documentation.

Launching ExtremeCloud IQ - Site Engine

Now that you have configured the ExtremeCloud IQ - Site Engine virtual engine, you are
ready to access ExtremeCloud IQ - Site Engine from a remote client machine.

Open a browser window on the remote client machine and enter the ExtremeCloud 1Q -
Site Engine Launch page URL in the following format:

https://<servername>:8443/

where <servername>is the ExtremeCloud 1Q - Site Engine virtual engine IP address or

hostname, and 8080 is the required port number. For example,
https://10.20.30.40:8443/

ExtremeCloud 1Q - Site Engine login page opens.

27 of 69



Onboarding ExtremeCloud 1Q - Site Engine

Log in as root with the same password you defined in step 3 or as the user you specified

in step 4.
This is because the ExtremeCloud 1Q - Site Engine Server has a single pre-defined user,

which is the user who performed the ExtremeCloud IQ - Site Engine installation. After the
initial user has logged in, additional users (with usernames valid for Ubuntu) can log in.

Onboarding ExtremeCloud IQ - Site Engine

To access ExtremeCloud IQ - Site Engine, you must first complete the steps to onboard
ExtremeCloud 1Q - Site Engine to ExtremeCloud IQ.

There are two scenarios by which you can onboard ExtremeCloud 1Q - Site Engine:

« After Upgrading to ExtremeCloud 1Q - Site Engine from Extreme Management
Center Versions 8.4.4 or 8.5.5.

« After Initial Installation of ExtremeCloud IQ - Site Engine

After Upgrading to ExtremeCloud 1Q - Site Engine from Extreme
Management Center Versions 8.4.4 or 8.5.5

When you upgrade from Extreme Management Center to ExtremeCloud 1Q - Site Engine,
if you used the softlaunch feature of Extreme Management Center in ExtremeCloud 1Q,

you need to remove Extreme Management Center from ExtremeCloud 1Q before
onboarding ExtremeCloud IQ - Site Engine.

After you upgrade your Extreme Management Center to ExtremeCloud 1Q - Site Engine,
you need to onboard ExtremeCloud IQ - Site Engine:

1. Loginto ExtremeCloud IQ - Site Engine. Enter your ExtremeCloud 1Q - Site Engine
username and password. Select Login.
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ExtremeCloud 1Q Site Engine

2. Accept the License Agreement.

Welcome to ExtremeCloud 1Q - Site Engine
License Agresment

PLEASE READ ALL OF THE FOLLOWING TERMS AND CONDITIONS OF THES END USER

LICENSE AGREEMENT. This End User Licénss Agrésment ["AQréement™) is 2 igal agrsament Ditwaen
You andior the entilty You represent and Exirerne Metworks, inC | on beh, el and £ afkates, INCluding
Bt not limited 10, Extrems Metwork insand Ops Limited (collectively, “Extreme”) fof the Software (defined
i) Boensad by AT OF IS BCENSONs.

By Soanioaing netalng cODyTY. ACOSAING Of USING e SoMaare of MINING 3 Sofaans Boands

By, OF Dy CROKING an 7 AQree” of Similar Bution. Of by Opening the Sofwarne madia, You agree 10 he

berms and condiions of his Agreement 5 3 CoNCBon of Your use o and nght 1o use. the SCMaare

¥ Yiou do nol agree 1o all The lerms and condions in his Agreement, do nol cownioad, instal or use

he Software. F The Softwane was delvered 0 You embesdded i an Exirems Hardware Froduct, oo not
nesiall oF LS Ml Exireme Handwane Product

Exfreme may make changes 1o this Agreement 21 2y brne and will provide wiitien noboe of such changes io
You &nd Jive You 30 ORENUnEY 10 SO0 Thodd CRANRGES . YOur CoOnDINued uie Of e SoMadng INer Such
changes have Deern poshed will :.-Ig:ﬁ yOuUF B3aen] 1o acoeptance of he evised hema.

¥ You and Extreme have sgned 3 SEparate Wimien aQneement COVETngG Your rights and duises wih respect 1o
e Software, M Mal willlen agreermen Lake preceaends ovel any CONMCng 1erms n Mis Agreerment

Yo privacy 15 mportant o Extiere  Extreme's Brivacy Policy 1§ ocaied af

Ffpes Mhvew Sxiremenetndrics COMCOMpam IeDalpifvaly PItdse dd our Privacy POBCy 1of INOImalion
pelated 1o Extreme's. CoBECTion, use and Sscosure of Your personal mformation By agressng 10 e lerms of
this Agreemeni. You @ee ais0 acoeping e berms of Exireme’s Privacy Policy

| accept the License Agresment

Select Next.

3. Toonboard ExtremeCloud IQ - Site Engine to ExtremeCloud IQ, provide your
ExtremeCloud 1Q email address and password.
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E ExtremeCloud 1Q Site Engine =

Welcome to ExtremeCloud 1Q - Site Engine
Onboard to ExtremeCloud 1Q

After ExtremeCloud IQ - Site Engine has successfully onboarded, you can now access
ExtremeCloud IQ - Site Engine.

If your environment requires HT TP Proxy or other advanced settings, select the
Advanced link. If you do not have an ExtremeCloud IQ account, select the Register Here
link.

After Initial Installation of ExtremeCloud IQ - Site Engine

Complete the following steps to onboard ExtremeCloud IQ - Site Engine after you install
ExtremeCloud 1Q - Site Engine:
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1. Accept the ExtremeCloud 1Q - Site Engine License Agreement.

Welcome to ExtremeCloud 1Q - Site Engine

License Agreement

accept the License -I"'-\f]rl:!'l'rrl'ul

2. Enter your ExtremeCloud |Q email address and password. Select Login.

-; ExtremeCloud IQ Site Engine =

Welcome to ExtremeCloud IQ - Site Engine
Onboard to ExtremeCloud IQ

Please enter your ExtremeCloud 12 credentials 1o onboard the ExtremeCloud 1Q - Site Engine

Cont have an account?

Onboard

If your environment requires HT TP Proxy or other advanced settings, select the
Advanced link. If you do not have an ExtremeCloud 1Q account, select the Register
Here link.

3. ExtremeCloud IQ retrieves the license information and sends it to ExtremeCloud 1Q
- Site Engine. ExtremeCloud 1Q - Site Engine is onboarded to ExtremeCloud IQ.
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You can now access the ExtremeCloud 1Q - Site Engine login page.

ExtrermneCloud 13 Site Engine

Enter the Username and Password you specified during the ExtremeCloud 1Q - Site
Engine installation.

Onboarding Devices

When ExtremeCloud 1Q - Site Engine has been onboarded, it can start sending requests
to add the devices from its database to ExtremeCloud Q.

NOTES: Devices with IPv6 addresses in ExtremeCloud IQ - Site Engine will not be
onboarded as locally-managed devices in ExtremeCloud IQ. Only devices
with IPv4 addresses qualify.

As devices are added and discovered in ExtremeCloud IQ - Site Engine, they are
onboarded to ExtremeCloud IQ, with a request for a license of the appropriate tier
(Navigator, Pilot or No License) that each device will require.

View the ExtremeCloud |Q - Site Engine and ExtremeCloud |1Q Onboarding Flowchart for
a detailed chart on how devices are onboarded to ExtremeCloud 1Q and managed by
ExtremeCloud IQ - Site Engine.

XIQ Onboarded Status for Devices

After an attempt is made to onboard a device, the XIQ Onboarded column of the
Network > Site > Device table indicates the status of the onboarding attempt.
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« Black check mark - Indicates that the device is onboarded to ExtremeCloud 1Q.

« Red X - Indicates the device is onboarded but Unmanaged, which means it is not
using a license, it has read-only device-level support, and available features in
ExtremeCloud 1Q - Site Engine are limited. Other functionality, including Status
Polling, Historical Device + Port Statistics Collection, Existing Scheduled Tasks,
and Archives, are supported for devices with Unmanaged status, but these devices
cannot be configured for new tasks or new archives.

NOTES: In ExtremeCloud IQ - Site Engine version 21.09.10, only use
ExtremeCloud IQ to set an ExtremeCloud 1Q - Site Engine onboarded
device to Unmanaged as a temporary measure while you obtain more
licenses.

If you mark a device as Unmanaged so it does not trigger a license limit
violation, you can then access ExtremeCloud 1Q - Site Engine and
delete the device before the license violation occurs.

You can perform an enforce for an ExtremeControl engine with an
Unmanaged status; however, if the device has an Unmanaged status,
then the enforce does not reconfigure the device and changes are not
written to the device.

When devices are marked as Unmanaged in ExtremeCloud IQ, they are also
Unmanaged in ExtremeCloud IQ - Site Engine.
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In addition, existing ExtremeAnalytics functionality for devices with an Unmanaged
status is still supported, but only with existing configuration.

« Blank - Indicates the device is not successfully onboarded to ExtremeCloud 1Q from
the ExtremeCloud 1Q - Site Engine because either it is already onboarded to
ExtremeCloud 1Q (either from another ExtremeCloud IQ - Site Engine or by using
the 1Q Agent to connect directly), or because ExtremeCloud IQ - Site Engine lost its
connection to ExtremeCloud IQ.

NOTE: If adevice's status is Blank, it has limited features available in ExtremeCloud IQ -
Site Engine because management of the device is owned by ExtremeCloud I1Q.

« N/A - Indicates the device is not eligible to be onboarded to ExtremeCloud IQ
because it does not have a valid serial number or MAC address, or Extreme does
not yet offer onboarding support for the device.

NOTE: If ExtremeCloud IQ - Site Engine does not recognize a device’s serial
number or MAC address, right-click on the device and select
Rediscover to attempt to discover the device’s serial number or MAC
address. After the device's serial number or MAC address is
discovered, it can be onboarded to ExtremeCloud IQ during the next
onboarding cycle.

Restoring a Database from a Windows Server to the
Engine

This section describes several ExtremeCloud 1Q - Site Engine configuration changes that
are required if you are moving your installation from a Windows platform system to the
ExtremeCloud 1Q - Site Engine virtual engine. Perform these steps after restoring your
database to the new engine. (For information on restoring a database, see the Server
Information section in the ExtremeCloud IQ - Site Engine Suite-Wide Tools User Guide.)

Changing Console

Use the following instructions to change the location of syslog and trap information to the
new location on the engine.
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Changing Syslog Location

Change the Syslog Log Manager to point to the new location on the engine. This will
enable the display of syslog information in the Syslog Event View tab.
1. From the Console menu bar, select Alarm/Event > Tools > Event View Manager.

2. Select on the Syslog entry under Available Log Managers, and select the Edit
button.
The Log Manager Parameters window opens.

3. Change the path in the Log Directory field to /var/log/messages.
4. Change the Pattern to Red Hat LINUX Syslog Pattern.
5. Select OK.

Changing Traps Location

Change the Traps Log Manager to point to the new location on the engine. This will
enable the display of trap information in the Traps Event View tab.

1. From the Console menu bar, select Tools > Alarm/Event > Event View Manager.

2. Select the Traps entry under Available Log Managers, and select the Edit button.
The Log Manager Parameters window opens.

3. Change the path in the Log Directory field to %logdir%/traps.
4. Select OK.

Changing Inventory Settings

If you are using Inventory Settings in ExtremeCloud 1Q - Site Engine, you must change
the Data Storage Directory path to point to the new location on the engine. The Data
Storage Directory is where all Inventory data is stored, including capacity planning
reports, configuration templates, archived configurations, and property files.

1. Select Administration > Options.

2. Expand the Inventory Manager options folder and select Directory Path in the
Data Storage section.

3. Change the path to the correct new location.
On a default installation, the path would be :/usr/local/Extreme_
Networks/NetSight/appdata/InventoryMgr/

4. Select OK.
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Changing ExtremeCloud IQ - Site Engine Engine
Settings
Use these steps if you need to change your ExtremeCloud IQ - Site Engine virtual engine

settings following your initial engine configuration. Perform these steps in the vSphere
client Console tab or login using an ssh session to ExtremeCloud IQ - Site Engine CLI..

Changing Basic Network Configuration

To change basic network configuration settings such as hostname and engine IP

address, enter the following command at the login prompt in the Console tab:
/usr/postinstall/dnetconfig

This will start the network configuration script and enable you to make the required
changes. You must reboot the engine for the new settings to take effect.

Changing SNMP Configuration

To change SNMP configuration settings such as system contact, system location, Trap
Server, SNMP Trap Community String, SNMP User, SNMP Authentication, and SNMP

Privacy credentials, enter the following command at the login prompt in the Console tab:
/usr/postinstall/snmpconfig

This will start the SNMP configuration script and enable you to make the required
changes.

Changing Date and Time Settings

To enable or disable NTP for engine date and time, or to manually set the date and time

on the engine, enter the following command at the login prompt in the Console tab:
/usr/postinstall/dateconfig

This will start the date and time configuration script and enable you to change the
settings.
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Upgrading ExtremeCloud IQ - Site Engine Engine
Software

Upgrades to the ExtremeCloud IQ - Site Engine engine software are available on the
ExtremeCloud 1Q - Site Engine web page.

Prior to performing an upgrade, you can create a snapshot of the engine that you can
revert to in the event an upgrade fails. Refer to the vSphere client documentation for
instructions on creating a snapshot.

1. On a system with an internet connection, go to the ExtremeCloud 1Q - Site Engine
web page: http://extranet.extremenetworks.com/downloads/pages/NMS.aspx.

2. Enter your email address and password.
You will be on the ExtremeCloud IQ - Site Engine page.

3. Select the Software tab and select a version of ExtremeCloud IQ - Site Engine.

4. Download the ExtremeCloud IQ - Site Engine virtual engine image from the
ExtremeCloud 1Q - Site Engine Virtual Appliance (engine) section.

5. Use FTP, SCP, or a shared mount point, to copy the file to the ExtremeCloud IQ -
Site Engine virtual engine.

6. SSHto the engine.
7. Cd to the directory where you downloaded the upgrade file.

8. Change the permissions on the upgrade file by entering the following command:
chmod + x ./ExtremeCloudIQSiteEngine <version> 64bit

install.bin

9. Run the install program by entering the following command:
./ExtremeCloudIQSiteEngine <version> 64bit install.bin

The upgrade automatically begins.

The ExtremeCloud 1Q - Site Engine Server are restarted automatically when the upgrade
is complete. Because your ExtremeCloud 1Q - Site Engine engine settings were migrated,
you are not required to perform any configuration on the engine following the upgrade.

Reinstalling ExtremeCloud IQ - Site Engine Appliance
Software

In the event that a software reinstall becomes necessary, restore an engine snapshot that
you previously made using the vSphere client. Refer to the vSphere client documentation
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for instructions on restoring a snapshot.

If you do not have an engine snapshot to restore, you must re-deploy and reconfigure the
ExtremeCloud 1Q - Site Engine virtual engine following the instructions in Engine
Deployment and this chapter.

Note: Be aware that a reinstall procedure reformats the hard drive, reinstalls all the
ExtremeCloud 1Q - Site Engine engine software, the operating system, and all related
Linux packages. We recommend backing up your hard drive before reinstalling.

38 of 69


../../../../../Content/Installation/XMC_Control_Analytics_VirtualEngineInstallGd/c_appliance_deployment.htm
../../../../../Content/Installation/XMC_Control_Analytics_VirtualEngineInstallGd/c_appliance_deployment.htm

Pre-Configuration Tasks

ExtremeControl Engine Configuration

After the ExtremeControl virtual engine has been deployed on a VMware ESX or ESXi
server, or a Hyper-V server using the instructions in Engine Deployment, you are ready to
perform the initial engine configuration process described in this chapter.

This chapter also includes information on how to change your engine settings following
your initial configuration, and how to upgrade or reinstall the engine software.

Pre-Configuration Tasks

Ensure that you have the following information prior to executing any of the procedures in
this chapter:

« Engine Hostname, IP address, and netmask

« Default Gateway IP address

« ExtremeCloud IQ - Site Engine Server IP address
« Name Server IP address and domain name

« Network Time Protocol (NTP) server IP address

Licensing for ExtremeControl

The licensing details for ExtremeControl vary depending on whether ExtremeCloud 1Q -

Site Engine is onboarded after upgrading from Extreme Management Center or if it is initially
installed.

After Upgrading From Extreme Management Center versions 8.4.4 or 8.5.5

If you are upgrading from Extreme Management Center versions 8.4.4 or 8.5.5 to
ExtremeCloud 1Q - Site Engine version 21.09.10, the licensing and capabilities of
ExtremeControl does not change. The following are included in the licenses:

« NMS-ADV License includes 500 Access Control End-Systems and 50 Guest and
loT Manager (GIM) licenses.

o NMS-xx License includes 250 Access Control End-Systems and 25 GIM licenses.

If you had an NMS-xx License with Extreme Management Center, you can upgrade to an
NMS-ADV License on the Extreme Portal after you onboard ExtremeCloud IQ - Site
Engine.

39 of 69


https://documentation.extremenetworks.com/netsight/XIQ-SE/XIQSE_21.04.10_Control_Analytics_Virtual_Engine_Installation_Guide.pdf
../../../../../Content/oneview/install/onboarding_XIQ.htm

Configuring the ExtremeControl  Engine

NOTE: Airgapped mode (where ExtremeCloud IQ - Site Engine is not connected to

ExtremeCloud 1Q) is not supported for ExtremeCloud 1Q - Site Engine
version 21.04.10.

Upon Initial Installation

If you are completing an initial install of ExtremeCloud 1Q - Site Engine, there is no end-
system license included. The evaluation license can be generated on the Extreme Portal
which includes unlimited end-systems and Guest and loT Manager (GIM) licenses.

Configuring the ExtremeControl Engine

To configure the virtual engine to run the ExtremeControl software:

1.

In the Console tab of the vSphere client, login as root with no password and press
[Enter].

The following screens display:

Welcome to Extreme Networks Access Control Engine 21.4.10.xx
controlengine login: root

Extreme Networks Access Control Engine 21.4.10.xx Configuration

Press CTRL-C to skip configuration for now

Please enter the information as it is requested to continue with the configuration.
Typically a default value is displayed in brackets. Pressing the [enter] key without
entering a new value will use the bracketed value and proceed to the next item.
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If a default value cannot be provided, the prompt will indicate that the item is either
(Required) or (Optional). The [enter] key may be pressed without entering data for
(Optional) items. A value must be entered for (Required) items.

At the end of the setup process, the existing settings will be displayed and
opportunity will be provided to correct any errors.

Press [enter] to begin setup or CTRL-C to exit:

. Press [Enter] to begin the setup.
The Root Password Configuration screen displays:

There is currently no password set in the system administrator account (root). It is
recommended that you set one that is active the first time the machine is rebooted.

Would you like to set a root password (y/n) [y]?

. Press [Enter] to set a new root password. Enter the new password as prompted.
Enter new UNIX password:

Retype new UNIX password:

Password updated successfully.

. In the ExtremeControl engine Configuration screen, enter the requested
configuration information for each line and press [Enter].

Enter the hostname for the appliance [nacappliance]:
Enter the IP address for <hostname> (Required):
Enter the IP netmask [255.255.255.0]:

Enter the gateway address [192.168.2.1]:

Enter the IP address of the name server (Optional):
Enter the domain name for <hostname> (Optional):
Enter the IP address of the Server (Required):
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5.

In the SNMP Configuration screen, enter the requested information for each line
and press [Enter].

The following information will be used to configure SNMP management of this
device. The SNMP information entered here must be used to contact this device
with remote management applications such as ExtremeCloud IQ - Site Engine
Console.

Please enter the SNMP user name [snmpuser]:

Please enter the SNMP authentication protocol - MD5 or SHA [MD5]:
Please enter the SNMP authentication credential [snmpauthcred]:
Please enter the SNMP privacy protocol - DES or AES [DES]:
Please enter the SNMP privacy credential [snmpprivcred]:

In the Configure Date and Time Settings screen, select whether you want to use
an external Network Time Protocol (NTP) server. Entery to use NTP, and enter
your NTP server IP address(es). Enter n to configure the date and time manually
and proceed to step 8.

The appliance date and time can be set manually or using an external Network
Time Protocol (NTP) server. It is strongly recommended that NTP is used to
configure the date and time to ensure accuracy of time values for SNMP
communications and logged events. Up to 5 server IP addresses may be entered if
NTP is used.

Do you want to use NTP (y/n) [y]? y

Please enter a NTP Server IP Address (Required): 144.131.10.120
Would you like to add another server (y/n) [n]? y

Please enter a NTP Server IP Address (Required): 144.131.10.121
Would you like to add another server (y/n) [n]? n
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7.

In the NTP Servers validate selection screen, enter 0 to accept the current settings
and proceed to the Set Time Zone screen at step 10.

These are the currently specified NTP servers. Enter 0 or any key other than a valid
selection to complete NTP configuration and continue. If you need to make a
change, enter the appropriate number from the choices listed below.
144.131.10.120

144.131.10.121

0. Accept the current settings

1. Restart NTP server selection

2. Set date and time manually

Enter selection [0]: 0

If you answered no to using an NTP server to set date and time, set the date and
time in the Set Date and Time screen.

The current system date and time is: Thu Apr 24 09:34:08 2018

Please enter the values for date and time as directed where input is expected in the
following format:

MM - 2 digit month of year

DD - 2 digit day of month

YYYY -4 digit year

hh - 2 digit hour of day using a 24 hour clock mm - 2 digit minute of hour

ss - 2 digit seconds

Please enter the month [04]:

Please enter the day of the month [24]:
Please enter the year [2018]:

Please enter the hour of day [09]:
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10.

11.

Please enter the minutes [34]:
Please enter the seconds [34]:

In the Use UTC screen, select whether you want the system clock to be set to use
UTC.

The system clock can be set to use UTC. Specifying no for using UTC,
sets the hardware clock using local time.

Do you want to use UTC (y/n) [n]?

In the Set Time Zone screen, select the appropriate time zone and press [Enter].

You will now be asked to enter the time zone information for this system.
Available time zones are stored in files in the /usr/share/zoneinfo directory.
Please select from one of the following example time zones:

1. US Eastern

2. US Central

3. US Mountain

4. US Pacific

5. Other - Shows a graphical list

Enter selection [1]:

In the Current Appliance Configuration screen, review the current settings and
press [Enter] to continue.
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Access Control Engine Configuration:

Host Info: <hostname>/<IP address>/<netmask>

Gateway/Name Server/Domain: <gateway>/<dns server>/<domain>
SNMP User: snmpuser

SNMP Authentication Protocol: snmpauthcred

SNMP Authentication: snmpprivcred

SNMP Privacy Protocol:

SNMP Privacy:

ExtremeCloud 1Q - Site Engine Server IP: <ECC server ip>

Press [enter] to continue:

In the Appliance Network Configuration Complete screen, you can accept the current
configuration or modify the settings.

Configuration of the appliance network settings is now complete. Enter O or any key other
than a valid selection to continue. If you need to make a change, enter the appropriate
number from the choices listed below.

0. Accept the current settings
1. Edit NAC Appliance settings
2. Edit SNMP settings

3. Edit date and time

4. Modify all settings

Enter selection [0]:

When you see the following screen, configuration is complete.

Setup of the NAC Appliance is now complete. Details of the appliance setup process are
located in the log files in the /var/log/install directory.

Note: After you have completed the configuration, it is important to take a snapshot of
your engine configuration to be used in the event an engine image reinstall is required.
For instructions on how to take a snapshot, see your vSphere client documentation.
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You are now ready to use ExtremeCloud IQ - Site Engine to manage your
ExtremeControl. If this is your initial commissioning of the engine, you can launch
ExtremeCloud 1Q - Site Engine and select Getting Started from the Help menu for
information on using ExtremeCloud 1Q - Site Engine to configure and manage your
ExtremeControl.

If you have reinstalled your ExtremeControl software, use ExtremeCloud 1Q - Site Engine
to enforce the engine. Enforcing writes your ExtremeCloud 1Q - Site Engine configuration
information to the engine.

Note:

When you add the virtual engine to ExtremeCloud IQ - Site Engine, you will be asked to
supply a virtual ExtremeControl engine license number. (When you purchased your
engine, you received a Licensed Product Entitlement ID. This Entitlement ID allows you
to generate a product license. Refer to the instructions included with the Entitlement ID
that was sent to you.)

Unlicensed virtual ExtremeControl engines will appear with an orange arrow icon in
ExtremeCloud 1Q - Site Engine, and cannot be enforced. You can view the engine license
status in the Administration > Diagnostics > Server > Server Licenses tab in
ExtremeCloud 1Q - Site Engine.

Changing ExtremeControl Engine Settings

This section provides instructions for changing your ExtremeControl engine settings
following your initial engine configuration, should the need arise. Depending on the
settings you want to change, you can use either the Control > Access Control tab of
ExtremeCloud 1Q - Site Engine or the vSphere client Console tab to make the changes.

Using the Access Control tab

Use the Access Control tab to easily change engine settings including DNS, NTP, SSH,
and SNMP configuration. You can also use the Access Control tab to change the engine
hostname and default gateway, as well as configure static routes for advanced routing
configuration.

Changing DNS, NTP, SSH, and SNMP Settings

Use the Engine Settings tab to change the following:
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« DNS Configuration — Search domains and DNS servers

« NTP Configuration — Time zone and NTP servers

« SSH Configuration — Port number and authentication

« SNMP Configuration — SNMP credentials for the engine

To access the Engine Settings tab:

o ~ w b=

6.

Open the Control > Access Control tab.

In the left-panel tree, expand the Configuration folder.

In the Configuration folder, expand the Global & Engine Settings folder.

In the Global & Engine Settings folder, expand the Engine Settings folder.

Select the desired engine (typically Default unless you have configured a custom
engine setting).

In the right panel, select the Network Settings tab.

Changing Hostname, Gateway, and Static Routes

On the Control > Access Control tab, use the Interfaces window for an engine to change
the engine hostname, default gateway, and static routes.

L nh =

Expand the Engines folder in the left-panel tree.
Select the ExtremeControl engine
Select the right-panel Details tab.

In the Interface Summary section, select Edit to open the Interfaces window where
you can change the engine hostname and default gateway.

5. Select Save.

In the Interface Summary section, select Static Routes to open the Static Route
Configuration window where you can add or edit the static routes used for
advanced routing configuration.

Using the vSphere Client Console Tab

Use the vSphere client Console tab to change the engine IP address, ExtremeCloud IQ -
Site Engine server IP address, and web service credentials. If desired, you can also use
the Console tab to change basic network settings such as engine hostname, SNMP
configuration, and date and time settings, although you should use NAC Manager to
make these changes, if possible (see Using the Access Control tab).
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Changing ExtremeControl Engine  Settings

Changing the ExtremeCloud IQ - Site Engine Server IP Address

To change the IP address of the ExtremeCloud IQ - Site Engine server, enter the

following command at the login prompt in the Console tab:
/opt/nac/configMgmtIP <IP address>

Enter the following command to start using the new ExtremeCloud 1Q - Site Engine

server:
nacctl restart

Changing Web Service Credentials

The Web Service credentials provide access to the ExtremeControl engine
Administration web page and the web services interface for the ExtremeControl engine.
Engines are shipped with a preconfigured default password.

If you have changed the credentials on the Access Control tab (in the Engine Settings
window) and then install a new engine that uses the default password, you will not be
able to monitor or enforce to the new engine until you change the password on the engine
using the command below. The credentials you enter on the engine must match the
credentials specified on the Access Control tab in the Engine Settings window.

To change Web Service credentials, enter the following command at the login prompt in
the Console tab:

/opt/nac/configWebCredentials <username> <password>
Enter the following command to restart the engine:

nacctl restart

Changing the Engine IP Address and Basic Network Settings

To change the engine IP address, as well as basic network settings such as hostname
and SNMP configuration (including system contact, system location, trap server, SNMP
trap community string, SNMP user, SNMP authentication, and SNMP privacy

credentials), enter the following command at the login prompt in the Console tab:
/usr/postinstall/nacconfig

This will start the network configuration script and enable you to make the desired
changes.
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Changing Date and Time Settings

To enable or disable NTP for engine date and time, or to manually set the date and time

on the engine, enter the following command at the login prompt in the Console tab:
/usr/postinstall/dateconfig

This will start the date and time configuration script and enable you to change the
settings.

Upgrading ExtremeControl Engine Software

Instructions for performing the software upgrade are available here.

Prior to performing an upgrade, you can create a snapshot of the engine that you can
revert to in the event an upgrade fails. Refer to the vSphere client documentation for
instructions on creating a snapshot.

Reinstalling ExtremeControl Engine Software

In the event that a software reinstall becomes necessary, restore an engine snapshot that
you previously made using the vSphere client. Refer to the vSphere client documentation
for instructions on restoring a snapshot.

If you do not have an engine snapshot to restore, you must re-deploy and reconfigure the
ExtremeControl virtual engine following the instructions in Engine Deployment and this
chapter.

Note: Be aware that a reinstall procedure reformats the hard drive, reinstalls all the
ExtremeControl engine software, the operating system, and all related Linux packages.
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Pre-Configuration Tasks

ExtremeAnalytics Engine Configuration

After the ExtremeAnalytics virtual engine has been deployed on a VMware ESX or ESXi
server, or a Hyper-V server using the instructions in Engine Deployment, you are ready to
perform the initial engine configuration process described in this chapter.

This chapter also includes information on how to change your engine settings following
your initial configuration, and how to upgrade or reinstall the engine software.

Pre-Configuration Tasks

Ensure that you have the following information prior to executing any of the procedures in
this chapter:

« Engine hostname, IP address, and netmask

« Default Gateway IP address

« Name Server IP address and domain name

« NIS (Network Information Services) Server IP address (optional)

« Network Time Protocol (NTP) server IP address

ExtremeCloud IQ - Site Engine And ExtremeAnalytics
Licensing

If you are an existing Extreme Management Center customer, contact your
representative to have your Extreme Management Center license migrated to an
ExtremeCloud 1Q - Site Engine license. The ExtremeCloud 1Q - Site Engine license also
includes licensing for ExtremeAnalytics.

NOTES: « ExtremeCloud IQ - Site Engine is a subscription-based -only licensing
model.

« ExtremeCloud IQ - Site Engine is not compatible with ExtremeCloud 1Q
Connect level account. Either the Pilot or Navigator level is mandatory.

You can view ExtremeCloud IQ and ExtremeCloud IQ - Site Engine license information
by accessing Administration > Licenses.

There are three tiers of licenses for ExtremeCloud IQ - Site Engine and devices:
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ExtremeCloud 1Q - Site Engine And ExtremeAnalytics Licensing

« Pilot - Extreme devices

« Navigator - 3rd party devices

« No License - Status-Only devices

As you begin to onboard ExtremeCloud |Q - Site Engine and your devices, ExtremeCloud
IQ will determine if you meet or exceed the license limits for each license type.

NOTE:

Devices that do not have serial numbers or MAC addresses in Extreme
Management Center must be Rediscovered after you upgrade to
ExtremeCloud IQ - Site Engine before they can be onboarded to
ExtremeCloud Q.

For the first 90 days after ExtremeCloud IQ - Site Engine is released, license
usage will not be enforced for devices onboarded to ExtremeCloud 1Q. When
ExtremeCloud 1Q starts evaluating license usage, if your number of devices
exceeds your licenses available, ExtremeCloud IQ - Site Engine transitions
to a license violation state and your access to ExtremeCloud 1Q - Site Engine
features and functionality is locked. To resolve the license shortage you need
to access the Extreme Networks portal or ExtremeCloud 1Q to evaluate the
quantities of available Pilot and Navigator licenses versus the number of
licenses required by ExtremeCloud 1Q - Site Engine.

Licensing for Devices

When ExtremeCloud 1Q - Site Engine has been onboarded, it starts sending requests to
add the devices from its database to ExtremeCloud I1Q.

As devices are added and discovered in ExtremeCloud 1Q - Site Engine, they are
onboarded to ExtremeCloud 1Q, with a request for a license of the appropriate tier
(Navigator, Pilot or No License) that each device will require.

Devices can be marked as Unmanaged in ExtremeCloud 1Q, which means they are not
using a license and available features are very limited.

The following grid details the type of license required by each device and engine type:

Number of
Device Type License Tier Type | Licenses
Per Device
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ExtremeCloud 1Q - Site Engine And ExtremeAnalytics Licensing

Extreme-supported Device
(Includes VSP, SLX, Extreme
Access, VDX, Fabric Manager,
Unified Switching VOSS, Unified
Switching EXOS, Summit Series, Pilot 1
ERS Series, 200 Series, 700
Series, A Series, B Series, C
Series, ICX Series, Security
Appliances, MLXe Series)

Chassis Pilot 1
ExtremeControlengine Pilot 1
ExtremeAnalyticsengine Pilot 1
ExtremeCloud 1Q - Site Engine Pilot 1
Extreme Management Center Pilot 1
vSensor Pilot 1
All Other Devices (Includes Non- Navigator 1
Extreme Device) —

Devices with Ping-Only profile No License 0

No License (These
are not onboarded to 0
ExtremeCloud 1Q)

Devices Added with No Access
Profile

No License (These
Status-Only Devices are not onboarded to 0
ExtremeCloud 1Q)

For HiveOS APs, a Pilot license is required, but currently not enforced in
NOTE: ExtremeCloud IQ - Site Engine Version 21.04.10. These are not onboarded to
ExtremeCloud 1Q through ExtremeCloud 1Q - Site Engine.
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License Limits and Violations

For each request to add a device to ExtremeCloud 1Q - Site Engine, ExtremeCloud 1Q
determines if there are enough licenses of that type available.

As a result, one of the following actions happens:

« Ifthere are enough licenses, device onboarding is successful.
« If there are not enough Navigator licenses, a Pilot license is used instead.

« If there are not enough Pilot licenses, the request is considered a license violation.

To correct a license limit violation, you must acquire more licenses (and, when the
updated license is sent to ExtremeCloud IQ, it is used by ExtremeCloud IQ - Site Engine).

Devices Marked as Unmanaged

When devices are marked as Unmanaged in ExtremeCloud IQ, they are also
Unmanaged in ExtremeCloud 1Q - Site Engine.

Onboarded Unmanaged devices are indicated in the XIQ Onboarded column of the
Network > Site > Device table by a red X.

For more details on the Network > Site > Device table, visit Onboarding Unmanaged
Devices.
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Configuring the ExtremeAnalytics Engine

Related Information

Onboarding ExtremeCloud |IQ - Site Engine

Configuring the ExtremeAnalytics Engine

To configure the virtual engine to run the ExtremeAnalytics application:

1. Inthe Console tab of the vSphere client, login as root with no password, and then

press [Enter].
The following screen displays.

2. Press [Enter] to begin the setup.
The Root Password Configuration screen displays:
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Configuring the ExtremeAnalytics Engine

administrator account (root). It is recommended that you set
one that isactive the first time the machine is rebooted.

Would you like to set a root password (y/n) [y]?

Note: You must set a new root password. This new root password will be used by
the initial user when logging in to the ExtremeAnalytics application.

Press [Enter] to set a new root password.
The following text displays where you can enter the new password:

Enter new UNIX password:
Retype new UNIX password:

From the ExtremeAnalytics Appliance (Engine) Deployment Modes screen, select
the deployment mode that matches your network environment.
The default deployment mode is 2.

This appliance supports multiple deployment modes to suit
different network environments and connectivity
characteristics. Please select a deployment mode below that
best fits your requirements.

0. Single Interface

A single interface is used for both management and
monitoring traffic.

Suitable for feeds from XOS/VOSS/SLX switches.

1. Single Interface With Tunnel
A single interface is used for both management and
monitoring traffic.
A GRE Tunnel will be configured for traffic monitoring.
Suitable for feeds from Coreflow switches.

2. Interface Mirrored
Separate interfaces are configured for management and
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monitoring traffic.

The monitoring interface will put into tap mode for
traffic monitoring.

Suitable for feeds from XO0S/VOSS/SLX switches.

3. Interface Tunnel Mirrored

Separate interfaces are configured for management and
monitoring traffic.

The monitoring interface will get its own IP Address
and GRE Tunnels will be configured for traffic monitoring.

Suitable for feeds from Coreflow switches.

4. Manual Mode

The interface and tunneling configurations will not be
modified by this script, leaving them to be manually edited
by the user instead.

Please select a deployment mode [2]:

Note: If you select deployment mode 4, refer to the ExtremeAnalytics Deployment
Guide for information on how to configure your deployment manually.

If you selected deployment mode 1, 2, or 3, the Appliance (Engine) Network
Configuration for ethO screen displays. For each line, enter the requested
configuration information and press [Enter].

If you will be using DNS, the IP address of the name server should be provided. If
you are using a name server then you must enter a domain name for the engine.
The NIS server is used to authenticate users logging into the engine. If you are
using an NIS server, make sure the NIS domain name is valid or users might not be
able to log in to the ExtremeCloud 1Q - Site Engine applications.

Enter information below to configure ethO

Enter the hostname for the appliance (Required) :
Enter the IP address for ethO on 10.54.56.141
[10.54.56.141]:

Enter the IP netmask [255.255.255.0]:

Enter the gateway address [10.54.56.2]:
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Enter the IP address of the name server (Optional) :
Enter the domain name for 10.54.56.141 (Optional) :

Enable NIS (y/n) [n]?

. Continue as follows:

For deployment mode 1, go to step 10.
For deployment mode 2, go to step 7.
For deployment mode 3, go to step 9.

If you are using a VMware server, proceed to Step 8. If you are using a Hyper-V
server, you need to change the configuration on the Windows Server system to
promiscuous mode by running the set promiscuous.psl script, included in the
ZIP file containing the virtual engine. When the files are extracted, the script is
saved in the directory to which you extracted the engine. The script enables the
ExtremeAnalytics sensor to see all traffic coming into the interface.

From an Administrator PowerShell on the Windows Server system, enter the
following command to run the script:

.\set promiscuous.psl VM Nameethl

VM Name - The name of the virtual machine as reported by Get-
VM

eth1-The default interface. This entry is optional.

. On the ExtremeAnalytics Engine, specify one or more tap ports. For each line, enter
the requested configuration information and press [Enter].

ExtremeAnalytics Appliance Network Configuration for Tap
Mode

Enter the interface name for Tap Mode [ethl]: eth4

Would you like to add another interface for Tap Mode (y/n)
[n]? vy

Enter the interface name for Tap Mode [eth2]: ethb

Would you like to add another interface for Tap Mode (y/n)
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10.

Enter the IP addresses for one or more GRE tunnels. For each line, enter the
requested configuration information and press [Enter]
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11.

settings.

The following example shows the Confirm Network Settings screen for deployment
mode 2.
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The following example shows the Confirm Network Settings screen for deployment
mode 3.
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12.

13.

The SNMP Configuration screen displays. For each line, enter the requested
information and press [Enter].
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Configuring the ExtremeAnalytics Engine

14. The Configure Date and Time Settings screen displays where you are asked if you

15.

want to use an external Network Time Protocol (NTP) server. Entery to use NTP,
and enter your NTP server IP address(es). Enter n to configure the date and time
manually and proceed to step 16.

Note that your VMS server should be using the same NTP settings as those
configured for your virtual engine (i.e., the same settings as the VMs that are hosted
on the VMS server).

The appliance date and time can be set manually or using an
external Network Time Protocol (NTP) server. It is strongly
recommended that NTP is used to configure the date and time
to ensure accuracy of time values for SNMP communications
and logged events. Up to 5 server IP addresses may be
entered if NTP is used.

Do you want to use NTP (y/n) [y]? y

Please enter a NTP Server IP Address (Required):
144.131.10.120

Would you like to add another server (y/n) [n]? y

The NTP validate selection screen displays. Enter 0 to accept the current settings
and proceed to the Set Time Zone screen at step 17.

These are the currently specified NTP servers. Enter 0 or
any key other than a valid selection to complete NTP
configuration and continue.

If you need to make a change, enter the appropriate number
from the choices listed below.

144.131.10.120

0. Accept the current settings
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16. If you answered no to using an NTP server to set date and time, the following
manual set date and time screen displays.

17. Enter n atthe Use UTC screen.
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18.

19.

The Set Time Zone screen displays. Select the appropriate time zone and press
[Enter]
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Launching the ExtremeAnalytics Application

Set the root user password

Set the host and network settings
Set SNMP settings

Set the system time

Modify all settings

g w NN

Enter selection [0]:

The ExtremeAnalytics application software is automatically installed. This could
take a few minutes. When the installation is complete, you’ll see the following
screen.

Extreme Networks - ExtremeAnalytics Appliance - Setup
Complete

Setup of the ExtremeAnalytics Appliance is now complete.

The appliance is now operational and ready to accept remote
connections.

Details of the installation are located in the
/var/log/install directory.

Note: After you have completed the configuration, it is important to take a snapshot
of your engine configuration to be used in the event an engine image reinstall is
required. For instructions on how to take a snapshot, see your vSphere client
documentation.

Launching the ExtremeAnalytics Application

Now that you have configured the ExtremeAnalytics appliance, you are ready to access
the ExtremeCloud 1Q - Site Engine Launch Page and run ExtremeAnalytics from a
remote client machine.

. Open a browser window on the remote client machine and enter the ExtremeCloud
|Q - Site Engine Launch page URL in the following format:
http://<servername>:8080/.
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where <servername> is the ExtremeCloud IQ - Site Engine server IP address or
hostname, and 8080 is the required port number. For example:
http://10.20.30.40:8080/.

On the ExtremeCloud IQ - Site Engine Launch Page, select OneView.
Note: The first time you attempt to launch an ExtremeCloud IQ - Site Engine
application, you will be prompted for the license text you received when you
generated your ExtremeCloud IQ - Site Engine product license.

At the login window, enter your ExtremeCloud IQ - Site Engine user name and
password.

On the ExtremeCloud IQ - Site Engine screen, select Analytics at the top of the
screen.

Select Dashboard.
The Dashboard tab displays.

Adding the ExtremeAnalytics Engine

To add the ExtremeAnalytics engine to ExtremeAnalytics:

1.

Select the Analytics Configuration tabAnalytics Configuration tab

2. Open the drop-down list below Overview and select Add Engine.

3. Enter the following information:

« |IP address of the ethO interface

« Name of the ExtremeAnalytics engine

4. From the Profile list, select the appropriate SNMP profile.
5. Select OK.

6. Open the drop-down list below Overview and select Enforce Engine.

Changing ExtremeAnalytics Engine Settings

Use these steps if you need to change your ExtremeAnalytics virtual engine settings
following your initial engine configuration. Perform these steps in the vSphere client
Console tab.
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Changing ExtremeAnalytics Engine Settings

Changing Basic Network Configuration

To change basic network configuration settings such as hostname and engine IP

address, enter the following command at the login prompt in the Console tab:
/usr/postinstall/dnetconfig

This will start the network configuration script and enable you to make the required
changes. You must reboot the engine for the new settings to take effect.

Changing SNMP Configuration

To change SNMP configuration settings such as SNMP Trap Community String, SNMP
User, SNMP Authentication, and SNMP Privacy credentials, enter the following

command at the login prompt in the Console tab:
/usr/postinstall/snmpconfig

This will start the SNMP configuration script and enable you to make the required
changes.

Changing Date and Time Settings

To enable or disable using NTP to configure the engine date and time, or to manually set
the date and time on the engine, enter the following command at the login prompt in the

Console tab:
/usr/postinstall/dateconfig

This will start the date and time configuration script and enable you to change the
settings.

Changing the ExtremeAnalytics Server I[P Address

To change the IP address of the ExtremeAnalytics server, enter the following command

at the login prompt in the Console tab:
/opt/appid/configMgmtIP <IP address>

Then, start using the new ExtremeAnalytics server by typing: appidctl restart.

Changing the Web Service Credentials

The Web Service credentials provide access to the ExtremeAnalytics Appliance
Administration web page and the web services interface for the ExtremeAnalytics engine.
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Engines are shipped with a preconfigured default password.

If you have changed the credentials in the Analytics tab and then install a new engine
that is using the default password, you will not be able to monitor or enforce to the new
engine until you change the password on the engine using this command. The
credentials you enter on the engine must match the credentials specified in the Web
Credentials section in Analytics > Configuration > Configuration.

To change Web Service credentials, enter the following command at the login prompt in

the Console tab:
/opt/appid/configWebCredentials <username> <password>

Then, restart the engine by typing: appidctl restart

Upgrading ExtremeAnalytics Engine Software

Upgrades to the ExtremeCloud 1Q - Site Engine engine software will be made available
from the Network Management Suite (NMS) Download webpage.

Prior to performing an upgrade, you can create a snapshot of the engine that you can
revert to in the event an upgrade fails. Refer to the vSphere client documentation for
instructions on creating a snapshot.

1. On a system with an Internet connection, go to the Network Management Suite
(NMS) Download web page:
http://extranet.extremenetworks.com/downloads/pages/NMS.aspx.

2. After entering your email address (username) and password, follow this path to the
download page: Visibility & Control > Network Management Suite (NMS) >
Software > select a version.

3. Download the following ExtremeAnalytics virtual engine file from the NMS
Downloads section:

purview appliance upgrade to <version>.bin

4. Use FTP, SCP, or a shared mount point, to copy the file to the ExtremeAnalytics
virtual engine.

5. SSHto the engine.

6. Cd to the directory where you downloaded the files.

7. Change the permissions on the upgrade file by entering the following command:

chmod 777 purview appliance upgrade to <version>.bin
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Reinstalling ExtremeAnalytics Engine Software

8. Run the install program by entering the following command:

./purview appliance upgrade to <version>.bin

The upgrade automatically begins. You are notified when the upgrade completes.

Reinstalling ExtremeAnalytics Engine Software

In the event that a software reinstall becomes necessary, it is recommended that you
restore an engine snapshot that you previously made using the vSphere client. Refer to
the vSphere client documentation for instructions on restoring a snapshot.

If you do not have an engine snapshot to restore, you will need to re-deploy and
reconfigure the ExtremeAnalytics virtual engine following the instructions in Engine
Deployment and this section.

Note: The re-installation procedure reformats the hard drive, reinstalls all the
ExtremeAnalytics engine software, the operating system, and all related Linux packages.
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